Legal information

Warning notice system
This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
Preface

Purpose of this documentation
This manual supports you during the configuration, installation, commissioning and operation of the TS Gateway application.

Validity of the documentation
This manual applies to the following software versions:
TS Gateway version V2.0 + Service Pack 3

New in this release
- New software version V2.0 + Service Pack 3
- New operating systems for TS Gateway (see section Installation, commissioning and operation (Page 13))
- Editorial revision

Replaced documentation
This manual replaces the manual release 03/2013.

Required experience
To be able to configure and operate the system described in this document, you require experience of the following products, systems and technologies:
- SIMATIC S7
- SIMATIC NET / Telecontrol
- STEP 7 Basic V12
- IP-based communication
You will find further reading in the References in this manual.

Further information on the Internet
You will find further information on the Siemens telecontrol products such as the latest information, manuals, FAQs or software updates on the Internet on the pages of Siemens Automation Customer Support under the following entry ID:
45605894 (http://support.automation.siemens.com/WW/view/en/45605894)
There select the required information under "Entry type" (for example "Updates", "Manuals", "FAQs" etc.).
TeleService example of an application on the Internet

An example of an application for TeleService access from an engineering station via the Internet to an S7 station with a CP 1242-7 can be found on the Internet on the pages of Siemens Automation Customer Support under the following entry ID:


SIMATIC NET glossary

Explanations of the specialist terms used in this documentation can be found in the SIMATIC NET glossary.

You will find the SIMATIC NET glossary here:

- SIMATIC NET Manual Collection
  The DVD ships with certain SIMATIC NET products.
- On the Internet under the following entry ID:
  50305045 (http://support.automation.siemens.com/WW/view/en/50305045)

Training, Service & Support

You will find information on Training, Service & Support in the multi--language document "DC_support_99.pdf" on the data medium supplied with the documentation.

Security information

Siemens provides automation and drive products with industrial security functions that support the secure operation of plants or machines. They are an important component in a holistic industrial security concept. With this in mind, our products undergo continuous development. We therefore recommend that you keep yourself informed with respect to our product updates. Please find further information and newsletters on this subject at: http://support.automation.siemens.com.

To ensure the secure operation of a plant or machine it is also necessary to take suitable preventive action (e.g. cell protection concept) and to integrate the automation and drive components into a state-of-the-art holistic industrial security concept for the entire plant or machine. Any third-party products that may be in use must also be taken into account. Please find further information at: http://www.siemens.com/industrialsecurity
Table of contents

Preface ...................................................................................................................................................... 3

1 Application and properties ......................................................................................................................... 7
  1.1 Properties.......................................................................................................................................7
  1.2 Configuration examples .................................................................................................................9

2 Installation, commissioning and operation ............................................................................................... 13
  2.1 Compatible operating systems for the application .......................................................................13
  2.2 Changing port and network settings ............................................................................................14
  2.3 Main and substitute TeleService gateway ...................................................................................15
  2.4 Wake-up SMS for the CP 1242-7 ................................................................................................16
  2.5 Overview of the passwords..........................................................................................................16

3 Configuration ........................................................................................................................................... 19
  3.1 The Configuration and Monitoring Tool (CMT) ............................................................................19
  3.2 Starting the CMT ..........................................................................................................................19
  3.3 Layout of the window ...................................................................................................................21
  3.4 Menu bar ......................................................................................................................................23
  3.5 Online help ...................................................................................................................................24
  3.6 Setting up users and administrators ............................................................................................24
  3.7 Creating and configuring projects ...............................................................................................27
  3.8 Settings ........................................................................................................................................30
  3.9 Configuring SMS gateway providers ...........................................................................................34

A Examples of the configuration data of SMS gateway providers ............................................................... 37

B References ............................................................................................................................................ 39

Index.......................................................................................................................................................... 41
Application and properties

1.1 Properties

Use of TS Gateway

TS Gateway is an application used for TeleService connections via GPRS with remote SIMATIC stations of the type S7-1200.

What is a TeleService gateway?

A TeleService gateway is a PC on which the "TS Gateway" software is installed.
The TeleService gateway is not configured in STEP 7.

What functions does the TeleService gateway provide?

The TeleService gateway has the following functions:

- Switching station
  The TeleService gateway is a PC in the network that serves as the intermediary between the engineering station and remote S7 station.
  Since a firewall is normally closed for connection requests from the outside, a switching station between the remote station and the engineering station is required. This switching station can be a telecontrol server or, if there is no telecontrol server in the configuration, a TeleService gateway. The switching station directs the messages via a tunnel through the firewall. This allows access by the engineering station connected to a LAN to the S7-1200 via a router and via the APN of the network provider.

- Configuration of the SMS gateway provider
  With the help of TS Gateway, SMS gateway providers are configured that are necessary for the sending of wake-up SMS messages to the remote S7 stations.

Configuration with TeleService gateway

A TeleService gateway is intended for the following telecontrol systems in which TeleService is used with GPRS:

- Configurations without a telecontrol server
  In configurations without a telecontrol server, a TeleService gateway is required for TeleService via GPRS.
1.1 Properties

- Configurations with telecontrol server

  In configurations in which a second path needs to be established for TeleService via GPRS alongside the telecontrol server, a TeleService gateway can be used.

  This can, for example, be the case when certain people, groups or companies should not operate TeleService via the telecontrol server or when access to the stations for TeleService needs to be set up independent of the telecontrol server.

Range of performance of a TS Gateway

- Number of simultaneous TeleService connections: 1

  **Note**

  **TS Gateway only for TeleService**

  TS Gateway is used only for the "TeleService" function via GPRS. No connections to the remote stations can be monitored and no process data can be transferred.

Main and substitute TeleService gateway

If the requirements for availability are higher, you can install TS Gateway as the main or substitute gateway. If the connection via the main system cannot be established, you can establish the TeleService connection via the substitute system. In terms of the range of functions, both systems are identical and do not monitor each other.

Requirements for TeleService with the TeleService gateway

The following requirements must be met for TeleService via a TeleService gateway:

- Engineering station connected to a LAN or with Internet access

  The engineering station on which TeleService will be operated via GPRS requires STEP 7, version V12.1 SP1.

  TeleService is started in the STEP 7 project that contains the remote station with the CP 1242-7.

- SIMATIC S7-1200
  - CPU with firmware version as of V2.0
  - Communications processor CP 1242-7

- PC for the TeleService gateway with:
  - DVD drive
  - Connection to LAN or Internet access for connecting to the engineering station
  - Internet access for connecting to the remote S7 station
  - Installation of the "TS Gateway" application

  The software ships with the CP 1242-7 (see product DVD).
1.2 Configuration examples

With an S7-1200 with CP 1242-7, TeleService via GPRS is always via the Internet and the GSM network.

The following figures show the typical configurations for the use of the TeleService gateway.

Installation of TS Gateway on the computer of the engineering Station

![Diagram of installation](image)

Figure 1-1 Installation of TS Gateway on the computer of the engineering Station

In this case, the "TS Gateway" application is installed on the engineering Station.
Installation of TS Gateway on a separate computer

In this case, the "TS Gateway" application is not installed on the engineering Station but on a separate computer. The engineering station and TeleService gateway are connected via an Intranet.
TeleService via a local and a remote engineering station

Figure 1-3  TeleService via a local and a remote engineering station

In this configuration, TeleService can be operated from two engineering stations:

- A central engineering station connected to the TeleService gateway via an intranet.
  
  The connection between the engineering station and S7 station is via the TeleService gateway, the Internet and the GSM network.

- A remote engineering station connected to the TeleService gateway via the Internet.
  
  The connection between the engineering station and S7 station is via the Internet to the TeleService gateway and from there further via the Internet and the GSM network.
Application and properties

1.2 Configuration examples
Installation, commissioning and operation

2.1 Compatible operating systems for the application

Compatible operating systems

the application can run on a PC with one of the following operating systems:

- Microsoft Windows 7 Professional 32/64-bit + Service Pack 1
- Microsoft Windows 7 Enterprise 32/64-bit + Service Pack 1
- Microsoft Windows 7 Ultimate 32/64-bit + Service Pack 1
- Microsoft Windows Server 2008 32-bit + Service Pack 1
- Microsoft Windows Server 2008 R2 64-bit + Service Pack 1

Firewall settings (ports)

Just as with any computer connected to the Internet or to another IP network, the TeleService gateway should be protected at least by the firewall of the operating system and/or the connected router against attacks from the connected network.

Remember that during installation of the system, several ports need to be opened and other changes need to be made in your system. These settings are displayed during installation. You can print these settings during the installation or save them in a log file.

Note

Response to a deactivated firewall

If the firewall is deactivated during installation, the necessary incoming and outgoing rules will not be created. In this case, no warning is output.

Commissioning the TeleService gateway

1. Set up the PC according to the documentation that ships with the PC.
2. Connect up the following connectors on the PC:
   - Monitor, keyboard, mouse
   - Power supply
   - Local area network if the engineering station is connected via a LAN.
   - Internet
     Note the information from the network provider and the manufacturer of the router
3. Turn on the PC.
4. Set up the following access:
   - Local LAN connection
   - Internet access

5. Insert the product DVD that ships with the CP 1242-7 in the DVD drive.

6. In the file management of the PC, open the DVD root directory > folder “TS Gateway”.

7. Start the installation by double clicking on the "setup.exe" file.

The installation of the software begins automatically. A wizard guides you through the remaining steps in installation.

![Window of the installation wizard of TS Gateway](image)

Figure 2-1 Window of the installation wizard of TS Gateway

### 2.2 Changing port and network settings

#### Network settings

To ensure that the system operates correctly, the following settings must be made:

1. Open the following dialog on the TeleService gateway:
   "Network and Internet" > "Network and Sharing Center" > "Advanced sharing settings"

2. Turn on "Network discovery" for both networks "Home or Work" and "Public".

#### Opening changed ports

If you change port numbers, you will need to open the ports used in the router or using the functions of the operating system.
Below you will find the ports of TS Gateway along with their significance and the default numbers:

- **Listener port for stations of the type S7-1200 + CP 1242-7**
  The port must be opened for communication with the engineering station and with remote stations of the type S7-1200 with CP 1242-7.
  Default port number: 55097

- **Port of the database server**
  Port of the database server for TCP connections with CMT client PCs
  Default port number: 26865

You can change the default port numbers in the CMT, refer to section Settings (Page 30) > "System configuration".

---

### 2.3 Main and substitute TeleService gateway

**TeleService gateway: Main and substitute server**

If TS Gateway is installed as the main and substitute TeleService server, two parallel systems are installed by TS Gateway and these are independent of each other. In terms of the range of functions, both systems are identical and do not monitor each other.

**Configuration of the main and substitute server**

Make sure that the configuration data on the two systems are consistent with each other. You can achieve this by entering all the configuration data twice manually or after configuring the main system, by copying the database of the main system to the substitute system using operating system tools. Follow the steps outlined below:

1. Copy the database file from the following directory of the main system:
   Programdata > Siemens > Automation > TCS Basic > Data > "Smsc.sqlite"

2. Insert the database file at the same location in the file system of the substitute system.
   The existing "Smsc.sqlite" file on the substitute system is overwritten.
   Copying ensures the consistency of the configuration data.

3. Adapt the addressing of the database server in the configuration of the substitute server in "Settings".

**Log files**

Since the main and substitute system have different dynamic characteristics relating to their runtime response, the log files have different contents in the database. When you copy the database, the log files are also copied.
2.4 Wake-up SMS for the CP 1242-7

Wake-up SMS

Waking the station by a TeleService gateway is achieved by sending an e-mail. The e-mail is sent to an SMS gateway via an SMTP server. The SMS gateway converts the e-mail into an SMS message and transfers this to the station.

The SMS gateway is configured in the CMT of the TeleService gateway, see section Settings (Page 30).

If the wake-up SMS message is sent from a phone, the number of the phone must be authorized in the STEP 7 configuration of the receiving CP (refer to "Authorized phone numbers"). The telephone must support the CLIP function (transfer of its own call number) and the sending of SMS messages.

The wake-up SMS message is not send extra when a TeleService connection is established, it is generated automatically by the TeleService gateway.

Depending on the switching TeleService gateway, the following text must be transferred in the wake-up SMS:

- Text for the wake-up SMS message for establishing a connection via the main TeleService gateway (TeleService server):
  
  **TELESERVICE**
  
  or
  
  **TELESERVICE 1**

- Text for the wake-up SMS message for establishing a connection via the substitute TeleService gateway (TeleService server):

  **TELESERVICE 2**

The configuration of the TeleService server for the GPRS CP is set in STEP 7 in "Telecontrol interface > TeleService authorization > 1st or 2nd TeleService server".

2.5 Overview of the passwords

Overview of the passwords used

Below, you will find an overview of the passwords used on the telecontrol Server / TeleService gateway.
### 2.5 Overview of the passwords

<table>
<thead>
<tr>
<th>No.</th>
<th>Password</th>
<th>System</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>User password / administrator password</td>
<td>CMT of the telecontrol server/TeleService gateway</td>
<td>Protection of the telecontrol server / TeleService gateway against unauthorized access</td>
</tr>
</tbody>
</table>
| 2   | Telecontrol password | • CP 1242-7  
• Station by station in the CMT of the telecontrol server/TeleService gateway | Authentication of the CP 1242-7 with the telecontrol server (protection of the telecontrol server) |
| 3   | TeleService password | CP 1242-7 | Protection from access to the CP in TeleService |
| 4   | Server password (optional) | Project by project in the CMT of the telecontrol server/TeleService gateway | Protection from access to the telecontrol server in TeleService |

Other passwords required by the GSM network provider, SMPT server provider or SMS gateway provider are not listed here.

**Overview of the passwords used (numbered symbols)**

![Diagram](image-url)
2.5 Overview of the passwords

Note

Server password

The server password can only be entered if projects have been created on the TeleService gateway and a server password was configured there. In all other cases, instead of this, a default internal system password is used automatically and is accepted by the TeleService gateway.

Number of TeleService connections

The TeleService gateway can only establish 1 TeleService connection at any one time.
### 3.1 The Configuration and Monitoring Tool (CMT)

The Configuration and Monitoring Tool (CMT) is the program user interface of TS Gateway and is used to configure the following parameters and settings:

- System settings (for example port numbers)
- Users
- SMS gateway provider
- SMTP server

**Functions not supported**

The CMT of TS Gateway is a special form of the CMT of the "TELECONTROL SERVER BASIC" (TCSB) software. In the program user interface, it contains several entries that are not supported by TS Gateway. These entries are identified by the note "Not relevant for TS Gateway".

### 3.2 Starting the CMT

**Starting the CMT**

To start the CMT, select the following program:

Windows Start menu > "SIMATIC" > "TCS Basic" > "Config and Monitoring Tool"

**Logging on**

When the program starts, the logon window of the CMT is displayed.

![Logon window of the CMT](image-url)

Figure 3-1 Logon window of the CMT
1. Enter a configured user name or leave the default user name.

2. Enter the corresponding password.

---

**Note**

The information in the drop-down list box "Database server" must not be modified.

3. Click the "Logon" button.

The window of the CMT opens.

The factory-set port numbers of TCSB are listed in the section Changing port and network settings (Page 14).

---

**Initial logon**

The following user data is set in the factory:

<table>
<thead>
<tr>
<th>User data</th>
<th>Default values set in the factory</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>User name</td>
<td>administrator</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>0000 (four zeros)</td>
<td></td>
</tr>
</tbody>
</table>

---

**Access protection of the system - changing passwords**

If you want to protect the system from unauthorized access, you should change the factory-set password. This procedure is described in the section Setting up users and administrators (Page 24).

---

**Entering the wrong user name or password**

If you enter a user name that is not configured, an error message is displayed regardless of the password entered. One or a variety of incorrect user names can be entered any number of times without the system being locked.

---

**Note**

**Incorrect entry of the password**

- If the default user name is entered:

  If you enter an incorrect password with the default user name (see above) an error message is displayed. You can attempt to enter the factory-set password any number of times to log on with the system.

  If you enter an incorrect password, a lock out time begins that is extended with each attempt to logon with an incorrect password.

- If you have entered a configured user name:

  If you enter an incorrect password along with a configured user name, an error message is displayed. You have a maximum of three attempts to log on correctly with a configured user name. After the third incorrect entry of the password, this user is locked out. Only an administrator can enable the user again.
Note

Loss of the administrator password

Note down a newly assigned or modified administrator password and keep this in a safe place.

If only one administrator is set up, the loss of the administrator password means that no more administrator tasks can be performed.

There is no way in which the system can be reset to the factory-set administrator password.

3.3 Layout of the window

Layout of the user interface

The program user interface of the CMT is divided into the following areas:

![Window layout of the CMT](image)

Figure 3-2 Window layout of the CMT

The subareas have the following functions:
### Light of the window

<table>
<thead>
<tr>
<th>No.</th>
<th>Area / subarea</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Title bar</td>
<td>Display of the name of the program</td>
</tr>
<tr>
<td>②</td>
<td>Menu bar</td>
<td>Contains the menus</td>
</tr>
<tr>
<td>③</td>
<td>Toolbar</td>
<td>Contains icons for individual functions</td>
</tr>
<tr>
<td>④</td>
<td>System navigation</td>
<td>Displays the structure of the configurable parameter types (administrators, SMS gateway providers). The individual objects of the selected parameter type are displayed in the object area.</td>
</tr>
</tbody>
</table>
| ⑤  | Object area        | The following content can be displayed:  
- Projects (optional)  
- Administrators  
- SMS gateway provider  
- System settings  
  The system settings are shown with the menu command "Options" > "Settings". |
| ⑥  | Parameter area     | Shows the parameters of the object selected in the object area.                                                                               |

The drop-down area "Activated parameters" at the right hand edge of the window is not relevant for the TeleService gateway.

### Invalid parameters

If you enter parameters in input boxes and these are found to be invalid by the plausibility check they are indicated during input with a red frame (see figure).

Invalid parameters are not stored in the database. If you exit a dialog with invalid data, the invalid configuration data will be discarded.

Figure 3-3  Marking of input boxes with invalid parameters (red frame)
3.4 Menu bar

The menu bar contains the following menus:

"File" menu

The following table shows the menu commands and corresponding functions:

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate</td>
<td>Transfers the configuration data of the selected project with a consistency check to the database of TS Gateway if this has not yet been stored. Activating transfers the configuration data of the entire project to the runtime system.</td>
</tr>
<tr>
<td>Reload</td>
<td>Not relevant for TS Gateway</td>
</tr>
<tr>
<td>Save</td>
<td>Checks whether modified configuration data is consistent and saves it. If the configuration data is inconsistent, an error message is displayed.</td>
</tr>
<tr>
<td>Exit</td>
<td>Closes the program.</td>
</tr>
</tbody>
</table>

"Edit" menu

This menu is used to edit configuration data. You can only edit configuration data if you have suitable rights for the selected project.

The following table shows the menu commands and corresponding functions:

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy</td>
<td>Copies an object or a group of objects to the clipboard.</td>
</tr>
<tr>
<td>Paste</td>
<td>Inserts an object or a group of objects from the clipboard.</td>
</tr>
</tbody>
</table>

"View" menu

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>System variables</td>
<td>Not relevant for TS Gateway</td>
</tr>
<tr>
<td></td>
<td>The system tags are not displayed in the TeleService gateway but are transferred from the S7 station to the engineering Station during a TeleService session.</td>
</tr>
</tbody>
</table>

"Options" menu

This menu is used to configure the TS Gateway system.

Only administrators have the right to make settings.
### 3.5 Online help

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
</tr>
</thead>
</table>
| Settings     | Opens the "Settings" dialog in the object area with the following parameter groups:  
  - General  
    Here, you can set the user interface language of CMT.  
  - System configuration  
    Here, you configure the system settings and the address and port parameters of the gateway.  
  - Trace levels  
    Not relevant for TS Gateway  
  - SMTP server  
    Here, you configure the SMTP server that sends the wake-up SMS sent by the CMT as an e-mail to the SMS GSM provider. (The e-mail it is converted to an SMS message there and forwarded to the remote station.) |

### "Help" menu

<table>
<thead>
<tr>
<th>Menu command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Opens the online help of the CMT.</td>
</tr>
<tr>
<td>About</td>
<td>Shows version information of the program.</td>
</tr>
</tbody>
</table>

### 3.5 Online help

#### Opening online help

The online help of CMT can be opened with the icon that you will find at the top right in the panes of the CMT window:

![Button for opening online help](Figure 3-4 Button for opening online help)

### 3.6 Setting up users and administrators

#### Introduction

Under the "Users" entry in the navigation area, you can, for example, create, configure or delete other administrators and users as deputies. They can configure the TeleService gateway.
Creating users is only necessary when certain users, for example, should only be able to read the data of the system. Otherwise, administrators can configure all projects and SMS gateway providers.

You can assign users to different projects and assign different rights to the users, see section Creating and configuring projects (Page 27).

View

If you select the "Users" entry in the navigation area, CMT lists all the entered users and their parameters:

The following parameters are displayed for a selected user:

- "General" parameter group

  The following data must be entered when they are created.

  - User name
    User name of the administrator. The user name must be unique throughout the system.

  - Password
    The password can be changed later by the logged-on administrator.

  - Repeat password

  - First name

  - Name
Configuration

3.6 Setting up users and administrators

- "Contact information" parameter group
  All contact information is optional and can be entered and modified by the relevant administrator.
  - E-mail address
  - Call number
  - Mobile
  - Address

Create administrators
Create new administrators as follows:
1. Click the "Create administrator" button.
   A new administrator is created.
2. Configure the administrator in the parameter area.

Note
Loss of the administrator password
Note down a newly assigned or modified administrator password and keep this in a safe place.
If only one administrator is set up, the loss of the administrator password means that the system can no longer be configured or modified.
There is no way in which the system can be reset to the factory-set administrator password.

Deleting administrators
Delete an administrator as follows:
1. Select the administrator to be deleted in the object area.
2. Click the "Delete user" button.
   The administrator is deleted.
3.7 Creating and configuring projects

View when the "Projects" entry is selected in the navigation area

With this selection, the CMT displays the following screen:

![Image of the CMT with the "Projects" tab selected]

Figure 3-6 Object area when the "Projects" entry is selected in the navigation area

The "Projects" tab displays the configuration data of the individual projects in the form of a table.

Purpose of creating projects

To use the functions of the TeleService gateway, it is not absolutely essential to create projects.

In larger systems, in which all stations are not accessed via the same SMS gateway provider, you can create various projects that are then assigned to a specific SMS gateway provider. The stations to be accessed via a specific SMS gateway provider are grouped together in a project. This means that you do not need to change the provider data each time.
A unique project number must be assigned to each CMT project that matches the project number of the CPs in the STEP 7 project.

---

**Note**

**Consistency with the STEP 7 project**

Make sure that the project number in the CMT is consistent with the project number of the CP 1242-7 in the STEP 7 project.

---

The SMS gateway provider is assigned to the project in the parameter area (see below).

---

**Parameters in the object area**

- **Status**
  Not relevant for TS Gateway

- **Project name**
  Name of the project

- **Project number**
  Number of the project

- **Project data**
  Not relevant for TS Gateway

- **First terminated connection**
  Not relevant for TS Gateway

- **Comment**
  Comment on the project

---

**Creating and deleting projects**

Only an administrator can create projects.

Create new projects as follows:

1. Select the "Projects" entry in the navigation area.
2. Click the "Add" button.
   The new project appears in the navigation area and in the object area.
3. Transfer the project to the database by clicking the "Activate" button (or alternatively with the menu command "File" -> "Activate").

In the same way, you delete a project with the "Delete" button. If a project has already been transferred to the database with "Activate", to delete the project completely, you need click the "Activate" button again.
Configuring projects

You create a configuration in the boxes of the parameter area.

- **SMS gateway provider**
  From the drop-down list, select the SMS gateway provider you want to assign to this project.

- **Server password**
  Password for authentication of the engineering station on the TeleService server (gateway).

  With the server password, free access from engineering stations to the TeleService server is blocked. This can help to prevent data volumes being generated that will lead to costs.

  The assignment of a password is optional:
  - If the server password is configured, the password must be entered with the request for a TeleService connection in the "Establish remote connection" dialog of STEP 7.
  - If no server password is entered, STEP 7 works on the basis of a password generated internally in the system. In this case, when a TeleService connection is requested, no server password is entered.

  **Note**

  **Substitute server**

  When installing a substitute gateway, make sure that the server password of the substitute gateway is identical to that of the main gateway.

Tabs in the object area

Select a project in the navigation area. The object area displays the following tabs:

- **"Connections" tab**
  Not relevant for TS Gateway

- **"TeleService connections to ES" tab**
  Not relevant for TS Gateway

- **"Rights" tab**
  Here, you can assign specific users to individual projects if users have already been set up.

  Only an administrator can assign rights.

  You can assign different rights to the individual users in the project.
One of the following user rights can be assigned to a user within a project:

<table>
<thead>
<tr>
<th>Function</th>
<th>Full access</th>
<th>Change</th>
<th>Wake up *)</th>
<th>Read</th>
</tr>
</thead>
<tbody>
<tr>
<td>View project</td>
<td>X</td>
<td>X</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Change configuration</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Assigning SMS</td>
<td>X</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>gateway provider</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

*) The "Wake" right is the same as the "Read" right.

Administrators are not listed here since they always have all rights.

Check the implications of the "Full access", "Change" or "Read" rights. See also section Setting up users and administrators (Page 24).

Assigning users

You create a configuration in the boxes of the parameter area.

Activating projects

Following configuration, you need to activate the project so that the new data is transferred to the runtime system.

3.8 Settings

Opening the "Settings" dialog

Open the "Settings" dialog box using the "Options" > "Settings" menu command. The possible system settings are distributed among the following parameter groups:

- General
- System configuration
- Trace activation
  - Not relevant for TS Gateway
- SMTP server
  Only administrators can make the settings for the system.

**General**

- Change log
  Not relevant for TS Gateway
- Language
  From the drop-down list, select the required language for the program user interface of the CMT.

**System configuration**

![System configuration dialog](image)

Figure 3-8   The "Settings" > "System configuration" dialog

Here, you configure the address data of the TeleService gateway and, if it exists, the substitute gateway.

- Authorized phone number
  Here, enter the string of numbers that authorizes the TeleService gateway to establish a connection with the CP.
  This number is transferred to the CP with the wake-up SMS message.
Note
Consistency with the STEP 7 project
The phone number entered here must be configured in the STEP 7 project of the CPs in
the list of 10 telephone numbers under the "Authorized phone number" parameter.

• Telecontrol Manager
Here, the IP address and the ports of the TeleService gateway are configured.
  – If you only install 1 TeleService gateway, go to the "Telecontrol Manager" list and
    select the entry "TeleServiceGateway_1" and configure the parameters.
  – If you install two gateways (main and substitute gateway, first select the
    "TeleServiceGateway_1" entry and configure this.
    Then select "TeleServiceGateway_2" and configure the second TeleService gateway.

Note
Consistency with the STEP 7 project or block configuration
The address data to be configured here is also configured in the STEP 7 project (CP
1242-7).

The relevant port numbers are preassigned. If necessary you can change these.
The following applies to all ports: The port number must be between 1 025 and 65 535.

  – Address
    IP address of the TeleService gateway
    Select one of the following entries:
    - The valid IP address of the computer
    - The entry "localhost"
    - The entry "127.0.0.1" for the main gateway
    - The entry "127.0.0.2" for the substitute gateway

Note
Use of the substitute gateway in the CMT
If you want to use the substitute gateway in the Configuration and Monitoring Tool
(CMT), you will need to configure the following address for the substitute gateway:
127.0.0.1

  – MSC Listener port
    Not relevant for TS Gateway
  – IP-T Listener port
    Port for connection requests from stations with CP 1242-7
    Default port number: 55097
  – Listener port for OPC
    Not relevant for TS Gateway
– TCM control port
  Not relevant for TS Gateway
– TCM data port
  Not relevant for TS Gateway
• Database server
  Not relevant for TS Gateway

**Note**
After changing and saving the information, a restart is necessary for the changes to take effect.

---

**SMTP server**

A wake-up SMS message of the TeleService gateway is sent as an e-mail. The SMTP server forwards the e-mail to the SMS gateway.

In this dialog, you can configure up to two SMTP servers:

• **Server 1**
  Main server to which all e-mails are sent.
• **Server 2**
  Substitute server to which the e-mails are sent if the main server is not obtainable.

The following parameters must be configured:

• **Mail server**
  SMTP address of the SMTP server
  Take the data from the agreement documents of your SMTP server provider.
• **User name**
  Take the data from the agreement documents of your SMTP server provider.
• **Password**
  Take the data from the agreement documents of your SMTP server provider.
• **E-mail address**
  Entry of own e-mail address.
3.9 Configuring SMS gateway providers

Function

The SMS gateway provider forwards a wake-up SMS message to the remote stations. The sequence of transmission is as follows:

1. The TeleService gateway sends an e-mail.
2. The e-mail is sent to an SMS gateway via an SMTP server.
3. The SMS gateway converts the e-mail into an SMS message and transfers this to the station.

One of more SMS gateway providers

To use the functionality of the TeleService gateway, you require at least one SMS gateway provider.

If you configure several SMS gateway providers, you can assign different providers to the various projects.

If you configure several SMS gateway providers, but no projects, the first SMS gateway provider in the list is always used.

View

Select the "SMS gateway provider" entry in the navigation area.

![Dialog box for configuring an SMS gateway provider](image)
The data of the SMS gateway providers that have already been created are displayed in the object area.

The data of the provider selected is configured in the parameter area.

**Identification: Authorized phone number**

To allow the CP 1242-7 to identify the TeleService gateway as the sender of the wake-up SMS message, a computer ID is transferred in the e-mail. This ID must be configured in the system settings as an "authorized phone number" before the sender of the SMS will be accepted by the CP. See also section Settings (Page 30).

**Parameter**

The columns contain the following parameters:

- **Name**
  Name of the SMS gateway provider
- **Address**
  E-mail address of the SMS gateway provider
- **Gateway data**
  The configured data of the provider is displayed here.

**Adding and deleting providers**

- "Add" button
  Adds a new SMS gateway provider.
- "Delete" button
  Deletes the selected SMS gateway provider in the object area.

**Configuring the parameters of the SMS gateway provider**

---

**Note**

**Parameters and placeholders**

Remember that the SMS gateway providers have different requirements for the parameters of the e-mail. You will find examples in appendix Examples of the configuration data of SMS gateway providers (Page 37). You will also find the significance of the placeholders <MSG> and <SMS-NO> there.

The data of the providers is entered in the parameter area:
3.9 Configuring SMS gateway providers

- **Name**
  Here, enter the name of the SMS gateway provider (can be selected freely).

- **Address**
  E-mail address of the SMS gateway provider.
  You will find the address in the agreement documents of your provider.

- **Re**
  Enter a suitable reference here.
  With some providers, the text field contains the information indicating to the recipient what needs to be done. The field can also include further job-specific information to allow use of special services of a provider.
  With some providers, the "authorized phone number" is entered here.
  Ask your provider about the reference.

- **Text**
  Enter a suitable text here.
  Ask your provider about the text.
Examples of the configuration data of SMS gateway providers

The following table contains several examples of the configuration of the SMS gateway providers on the CMT. See also section Configuring SMS gateway providers (Page 34).

You can find out from your SMS gateway provider how to configure the e-mail for the wake-up SMS message.

Table A-1 SMS gateway provider-related e-mail structures

<table>
<thead>
<tr>
<th>SMS network provider</th>
<th>E-mail address of the SMS gateway provider *</th>
<th>Re **</th>
<th>Text **</th>
</tr>
</thead>
<tbody>
<tr>
<td>E-Plus</td>
<td>&lt;SMS-NO&gt;@smsmail.eplus.de</td>
<td>&lt;MSG&gt; *</td>
<td>&lt;MSG&gt; *</td>
</tr>
<tr>
<td>O2</td>
<td>&lt;SMS-NO&gt;@o2online.de ***</td>
<td>&lt;MSG&gt; *</td>
<td>&lt;MSG&gt; *</td>
</tr>
<tr>
<td>Smstrade</td>
<td>&lt;SMS-NO&gt;@email2sms.smstrade.de</td>
<td>&lt;MSG&gt; *</td>
<td>#Identifikationkey #Sendroute #Sender#</td>
</tr>
<tr>
<td>T-Mobile</td>
<td>&lt;SMS-NO&gt;@t-mobile-sms.de</td>
<td>&lt;MSG&gt; *</td>
<td>&lt;MSG&gt; *</td>
</tr>
<tr>
<td>Vodafone</td>
<td>&lt;SMS-NO&gt;@vodafone-sms.de</td>
<td>&lt;MSG&gt; *</td>
<td>&lt;MSG&gt; *</td>
</tr>
</tbody>
</table>

* <SMS-NO>
When configuring the e-mail address of the SMS gateway provider in the "Address" box, enter the placeholder "<SMS-NO>". TCSB then automatically enters the call number of the SIM card of the CP that originates from the CP configuration in STEP 7 and is transferred in the frame of the engineering station.

** All cells of the table with the entry "<MSG>"*
Enter the placeholder "<MSG>" in the "Re" or "Text" box. TCSB then automatically enters the correct message that is stored in the system and understood by the CP 1242-7. (This is the same text that is transferred in a wake-up SMS as the message text.) Wake-up SMS for the CP 1242-7 (Page 16)

*** The call number of the SIM card may only be entered in STEP 7 without the international country dialing code.

Activating the e-mail address

To receive the e-mail, a personal mobile e-mail address needs to be activated with some network providers. To do this, send an activation SMS with a short number to your SMS network provider that you will find in the table below "Activation and deactivation SMS". You will receive a personal e-mail address via SMS that is normally made up of the phone number and the gateway name.

To activate your personal mobile e-mail address, send the special activation text to a short number of your SMS network provider.
You will receive a reply SMS with your personal mobile e-mail address that is made up of your phone number and the gateway name of your SMS network provider, for example: 0123412345678@providersms.com

You will find examples of activation texts and short numbers of SMS network providers in the following table.

**Note**
Check with your network provider whether or not it is necessary to send activation and deactivation SMS messages. Your network provider will inform you of the texts and short number.

<table>
<thead>
<tr>
<th>Gateway name</th>
<th>E-Plus</th>
<th>O2 Germany</th>
<th>T-Mobile</th>
<th>Vodafone</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabling</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send SMS with text to short number</td>
<td>Text: START</td>
<td>Text: OPEN</td>
<td>Text: OPEN</td>
<td>Text: OPEN</td>
</tr>
<tr>
<td>Short number: 7676245</td>
<td>Short number: 6245</td>
<td>Short number: 8000</td>
<td>Short number: 3400</td>
<td></td>
</tr>
<tr>
<td>Deactivating</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Send SMS with text to short number</td>
<td>Text: STOP</td>
<td>Text: STOP</td>
<td>Text: CLOSE</td>
<td>Text: CLOSE</td>
</tr>
<tr>
<td>Short number: 7676245</td>
<td>Short number: 6245</td>
<td>Short number: 8000</td>
<td>Short number: 3400</td>
<td></td>
</tr>
</tbody>
</table>
Where to find Siemens documentation

- You will find the order numbers for the Siemens products of relevance here in the following catalogs:
  - SIMATIC NET Industrial Communication / Industrial Identification, catalog IK PI
  - SIMATIC Products for Totally Integrated Automation and Micro Automation, catalog ST 70

  You can request the catalogs and additional information from your Siemens representative.

- You will find SIMATIC NET manuals on the Internet pages of Siemens Automation Customer Support: Link to Customer Support
  (http://support.automation.siemens.com/WW/view/en)

  Enter the entry ID of the relevant manual as the search item. The ID is listed below some of the reference entries in brackets.

  As an alternative, you will find the SIMATIC NET documentation on the pages of Product Support:

  Go to the required product group and make the following settings:

  "Entry list" tab, Entry type "Manuals / Operating Instructions"

  You will find the documentation for the SIMATIC NET products relevant here on the data medium that ships with some products:

  - Product CD / product DVD or
  - SIMATIC NET Manual Collection

/1/

SIMATIC NET
CP 1242-7
Operating Instructions
Siemens AG
entry ID: 61029644
References

/2/
SIMATIC NET
TELECONTROL SERVER BASIC
Operating Instructions
Siemens AG
entry ID: 50898745

/3/
SIMATIC NET
TS Gateway
Operating Instructions
Siemens AG
Entry ID: 48548898
Index

A
Activate, 30
Administrator, 28
Administrator password, 26
Authorized phone number, 35

C
Current information, 3

F
FAQs, 3
Firewall settings, 13

G
Glossary, 4

H
Help, 24

I
Invalid parameters, 22

L
Language selection, 31
Log files, 15

M
Main gateway, 8
Main TeleService gateway, 16
Manuals, 3

N
Network settings, 14

O
Online help, 24
Operating system, 13

P
Password
  Invalid entry, 20
  Overview, 16
Port numbers, 32
Ports
  Numbers, 14
  Opening, 14

R
Rights, 29
Runtime system, 30

S
Server password, 29
Service & Support, 4
Settings, necessary, 14
SIMATIC NET glossary, 4
SMTP server, 33
Substitute gateway, 8
Substitute server, 29
Substitute TeleService gateway, 16

T
TeleService server, 16
Training, 4
TS Gateway, 8
Index

U
User name: Invalid entry, 20
User permissions, 29

V
Validation, 22

W
Wake-up SMS, 16